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After you've become familiar with the topics covered in Getting started with 
Vicon Shogun, you may want to take your use of Shogun further. The following 
topics in this guide describe some of the ways in which you can do this.

Map pose and best rig practices, page 3

Work with custom props and meshes, page 6

Work with objects in Shogun Post, page 11

Understand object tracking in Shogun Live, page 15

Use Auto-Skeleton, page 24

Create a subject calibration hotspot, page 36

Run Shogun processing on multiple machines, page 42

Visualize camera coverage, page 47

Set up SDI video cameras, page 52

Export and use an ST map, page 113

UDP capture broadcast/trigger, page 125

Specify folders in Shogun Post, page 135

Using marking menus, page 139

Vicon Shogun command line options, page 146

For information on scripting with Shogun, see HSL scripting with Vicon Shogun
and for information on retargeting, see Retarget with Shogun Post in Getting 
started with Vicon Shogun.
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Map pose and best rig practices
Map pose is used to constrain the target skeleton to the source skeleton. To get 
the optimum results from the retarget, the source and target poses need to be 
as close as possible.

When you click Set Map Pose, Shogun Post takes any differences between the 
two skeletons and stores them as offsets within the VSR file. Any joints with 
default values or keys are copied onto pre-rotation to match the source Vicon 
skeleton and stored as the map pose for the solver to use. The original values are 
maintained in the FBX or USD skeleton, enabling the skeleton to be imported 
back onto the original rig without any issues.

In addition to supporting the use of skeletons that use pre-rotation to define the 
base pose (see Retarget with Shogun Post in Getting started with Vicon Shogun), 
Shogun Post also supports the use of skeletons that have zeros for pre-rotation 
and use keys or default values to achieve this.  

For example, Mannequin.FBX is a commonly used target skeleton. It contains 
joints like the clavicles which, instead of using pre-rotation, use keys to define a 
base pose, (or more accurately, the appearance of a base pose, as the actual 
base pose is not a real base pose.)
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When Mannequin.FBX is loaded into AutoDesk® MotionBuilder®, at first glance 
it appears to be in a base pose:

However, notice that the pose is actually defined by a set of keys on frame 0 and 
the pre-rotation (as seen in the Properties) is zeros for bones like the clavicle, 
which have a rotation so the X axis can point to the side even though its parent 
has the X pointing up.



B E Y O N D  M O T I O N

Map pose and best rig practices

Getting more from Vicon Shogun

05 October 2021

Page 5 of 148

•

•

To see the actual base pose, delete the keys and set all the rotation values for all 
bones to zero:

This demonstrates why it's better to use the pre-rotation to define the base 
pose. When all keys are removed, and all bone set to zeros, it's preferable to 
have a base pose that's a clear T- or A-pose instead of the stack of bones shown 
above. It's also more sensible because the animation you place on a skeleton via 
mocap or hand-keying is easier to deal with when poses are relative to zero. For 
example, it's easier to think of a bend of the elbow as X degrees from 0, not X 
from 90, which is what you'd have if straight was actually 90 because of the 
current base pose.

Ideally, you would rebuild skeletons like this to use pre-rotation instead, but this 
is not always possible. When it's not possible, you can still use the skeleton, but 
you must set the map pose (see Retarget with Shogun Post in Getting started 
with Vicon Shogun).

Benefits of using map pose:

The pose used during mapping is saved and restored when you go back into 
map mode or load the VSR into the Retarget app.

The target skeleton matches the source skeleton's joint orientation more 
closely, resulting in a better solve.
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b.
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Work with custom props and meshes
You can add custom prop meshes in Shogun Live and manipulate the prop 
during a shoot. These updates are seen instantaneously in engine, so that you 
can correctly position props and virtual cameras.

 Watch the Vicon video, Shogun Live Prop Manipulation1 on YouTube.

 Watch the Vicon video, Shogun Live Prop Manipulation2 on Vimeo.

For information on using a custom L-frame to set the origin, see Set the origin 
with a custom L-frame in Getting Started with Vicon Shogun, Calibrate cameras.

For information on linking a calibrated SDI or Vicon Vue video reference cameras 
to a rigid tracking object, to enable the video camera to be tracked, see Link a 
prop and a video camera, page 9.

To create custom props:

To make a custom prop mesh available in Shogun, copy the .fbx file into C:
\Users\Public\Documents\Vicon\PropMeshes.
(Any skinned FBX object can be a prop, provided the skin bone is called 
Root.)
You can now select it from the Mesh drop down list as described below.

In Shogun Live, to make it easy to select the required trajectories, in a 3D 
Perspective pane, pause the real-time stream (press the space bar).

Select the markers in the correct order:

Root

Target

Up vector

Any other markers

Note 
As the videos were recorded using an earlier version of Shogun, you 
may notice minor differences in the user interface.



https://youtu.be/o7X0QICz3H0
https://youtu.be/o7X0QICz3H0
https://vimeo.com/275782908
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In the Tracking tab, ensure the Setup tab is selected and in the Prop field, 
enter the name of the prop.

Click Create.

On the Properties tab, from the Mesh dropdown menu, select the .fbx that 
you made available in Step 1.

Un-pause the real time  (press the space bar again) to see the prop and mesh 
move together.
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10.

To change the view of props independently of subjects, select View Filters
and then select the Props options that you want at the bottom left of the 
pane.

 

To change the position of your new prop, pause the scene, select the root 
bone and use the Object Manipulator (select it at the top of the 3D Scene 
view or press M). Note that you can't currently use the manipulator in the 
Cameras view.

When you have finished manipulating the prop, its constraints are 
automatically updated and a new version is saved.
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Link a prop and a video camera
Shogun Live lets you link a calibrated SDI or Vicon Vue video reference camera 
to a rigid tracking object. This enables the video camera to be tracked, providing 
real-time 3D overlay in Shogun Live while the camera is moving and enabling the 
animation to be captured to the MCP.

To link a calibrated video camera and a rigid tracking object:

Create the object (normally a tracking crown or set of markers attached to the 
camera) in the usual way:

In the 3D Scene, select the relevant markers.

In the Tracking panel, with the Setup tab selected, go to the Prop field, 
enter a name for the object and click Create.

If you want to use the object tracker (see Understand object tracking in 
Shogun Live, page 15), on the Properties tab, ensure Track with 
ObjectTracker is selected.

At the top of the Tracking panel, ensure the object is selected.

In either the Workspace view pane or the System tree, Ctrl-click to select a 
calibrated video camera.

In the Tracking panel, on the Setup tab, click Link Camera.
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The button text changes to display identifying information for the linked 
camera and the bone for the prop moves to the video camera's optical 
center, aligned with the video camera's coordinate system.
You can now move the camera while maintaining the 3D overlay, and you can 
see the camera moving in the 3D Scene and Cameras views. 

To detach a video camera and rigid tracking object:

At the top of the Tracking panel, select the prop that you want to unlink from 
the video camera.

On the Setup tab, to the right of the Link Camera button, click Unlink.
The prop and camera are unlinked, and no longer move together. The prop 
origin remains at the video camera optical center, and the video camera 
remains in its last position.

If you recalibrate the linked video camera, for example, following a zoom lens or 
tracking crown location change, the linked prop is also automatically updated so 
that the correct calibrated nodal point is maintained.

After you have captured a scene with linked video cameras, you can load the 
MCP into Shogun Post. The linked video cameras display the same animation in 
Post, with a key per frame for translation and rotation.
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Work with objects in Shogun Post
For information, see:

Create multiple objects, page 12

Work with FBX objects, page 13



B E Y O N D  M O T I O N

Work with objects in Shogun Post

3 https://youtu.be/x2W3tsnm8gg

Getting more from Vicon Shogun

05 October 2021

Page 12 of 148

1.

2.

3.

a.
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5.

Create multiple objects
To make it quicker and easier to create multiple instances of an object in Shogun 
Post (for example, if you want to create a number of cameras to help you to 
visualize a new capture space), you can specify the number of objects to create 
when you create an object.

To create multiple objects:

On the Objects menu, point to Create objects, then click Create Object.

On the left of the Create Object dialog box, click the type of object you want 
to create (in this example, Camera).

On the right of the dialog box:

Enter a name for the object you're creating.

In the Options select Create Multiple and if necessary, change the value to 
the required number of objects.

Click OK.

To check that your new objects are displayed, open a Selection panel.

With the Object Manipulator, move the objects to their required positions.

 For tips on creating multiple objects and using the Selection panel, see 
Vicon Shogun 1.3 Post Tutorial - Object Creation and Selection List3 on 
YouTube.

https://youtu.be/x2W3tsnm8gg
https://youtu.be/x2W3tsnm8gg
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1.
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Work with FBX objects
To help you visualize your scene, you can import FBX files to use as objects in 
your scene in Shogun Post. You can also create Mesh objects, to which you can 
attach FBX files, and manipulate them within your Shogun scene.

This might be useful when you want to visualize your existing 3D environment 
within Shogun to enable you to position the characters accurately, or to help with 
camera placement.

 For more information, see the following steps and watch Vicon Shogun 1.3 
Post Tutorial - Static FBX Meshes4 on YouTube.

To import an FBX file as a static object:

Drag the FBX file into the Shogun Post view pane.

When you are prompted, choose Mesh.

https://youtu.be/fq9Iz9HEsDM
https://youtu.be/fq9Iz9HEsDM
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To create a static FBX object:

On the Objects menu, point to Create objects, then click Create Object.

On the left of the Create Object dialog box, click Mesh, enter a name for the 
new object on the right and then click OK.

 

In the Attributes panel, enter or browse to the FBX file of the required mesh.

 

When you have created or imported the object, you can then move the object to 
the required position as normal.
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Understand object tracking in Shogun Live
With Shogun 1.6 and later, you can specify that a selected rigid object is tracked 
using a custom object tracker.

Conventional object tracking requires at least three cameras with an unoccluded 
view of a marker to be able to reconstruct it in 3D. The object tracker is an 
alternative set of algorithms that are based on computing the 6DoF pose of the 
object directly, using 2D centroid data. 

The advantage of this approach is that Shogun produces tracking that is robust 
to occlusion and and can track the object into parts of the volume where it may 
not be possible to form enough reconstructions for the conventional approach 
(Full Body) to apply. Latency is also minimized as it is not necessary to wait for 
reconstruction, labeling and solving to complete before an object pose is 
obtained.
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2.

The reconstructions generated by the reconstructor are used by the object 
tracker to boot a solution but are not needed on every frame, allowing the object 
tracker to generate results even in situations where the Full Body solution drops 
frames. 

To use the object tracker:

Create the object in the usual way:

In the 3D Scene, select the relevant markers.

In the Tracking panel, with the Setup tab selected, go to the Prop field, 
enter a name for the object and click Create.

On the Properties tab, ensure Track with ObjectTracker is selected.
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Specify settings for optimal object tracking
If you can't see these parameters, at the top of the relevant panel, click Show 
Advanced.

System panel settings, page 17

Processing panel settings, page 21

Tracking panel parameters, page 23

System panel settings
Towards the top of the System tab, the following Advanced global parameters 
that relate to object tracking are displayed:

Setting Description

Force Lowest 
Latency

Some models of Vicon cameras can be forced into a mode to 
provide the lowest possible latency at the cost of reducing 
grayscale and centroid throughput. Generally, select this setting 
only when using low-latency object tracking. 
However, note that for some large systems with a high number of 
cameras, this may cause network problems that manifest as 
cameras appearing to drop out. For more information, see Use the 
Force Lowest Latency option, page 18.
Default: Cleared

Object Tracking 
Level

Set the camera and processing parameters to the required level of 
object tracking:

Standard: Basic level involving no camera changes

Use Grayscale: Enables object pose jitter reduction using 
grayscale data.
Note that this requires camera to send only grayscale data, 
which for large camera counts may cause network issues.

Object Tracking Only: As for Use Grayscale and enables 
lower quality centroid data to further reduce jitter.

Default: Standard
See also Handling jitter, page 20. 
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Use the Force Lowest Latency option

To enable you to to achieve lowest latency possible for object tracking, so that 
external devices driven by object pose (such as an LED wall virtual camera driven 
by a Vicon-tracked hero camera) are as close to real time as possible, you can 
control whether any attached Vicon cameras have their DSPs (Digital Signal 
Processors) enabled or not.  You do this by selecting or clearing the Force 
Lowest Latency option. Selecting this option provides the lowest possible latency 
at the cost of reducing grayscale and centroid throughput. However, it is 
normally only useful if you are using low-latency object tracking (see Use the 
object tracker, page 16).

Note that this feature is not available for Vicon cameras that do not have a DSP.

To use the Force Lowest Latency option:

Connect Shogun Live to a system containing Vicon optical cameras that have 
a DSP, such as Vantage and/or ViperX, with a number of markers scattered 
throughout the volume.

On the System panel, ensure the Advanced options are displayed. If not, at 
the top right of the Systems panel, click Show Advanced. 

•

•

Caution

If you are tracking only a single object or a few rigid objects, you may 
want to reduce the camera delivery latency and instead allow Shogun, 
rather than the camera, to fit grayscale blobs. In this case, you can 
select Force Lowest Latency.

However, we advise you not to select Force Lowest Latency if the 
system contains a significant number of Vantage cameras and/or a lot 
of markers, as this can overload the network with grayscale data.


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Select Force Lowest Latency. 

 

This ensures that any attached cameras with DSPs do not use them.

If you select Force Lowest Latency in a system with a large number or cameras 
and/or markers, the cameras may overload the network with grayscale data, 
which can result in HAL error messages in the Log, and cameras appearing to 
drop out or show as not transmitting data (ie, in the System panel, their icons are 
gray or flicker to gray). To minimize this effect:

If possible, use 10 GB networking, rather than 1 GB networking.

On the System panel, check the Object Tracking Level. If possible, set it to 
Standard, rather than Use Grayscale or Object Tracking Only, which forces the 
cameras to send grayscale data.

For all cameras, check that their  Grayscale Mode (found in the Optical Setup 
section of the System panel) is NOT set to Only.

Note that the Force Lowest Latency setting is not available if no cameras with 
DSPs are attached to the system.
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Handling jitter
Jitter is mainly caused by these issues:

Changing sets of centroid-label correspondences (rays)  contribute to the 
object, interacting with small inaccuracies in the camera calibration so that 
flickering contributions cause the optimum pose to jump about.

Noise on the centroids cause the optimum pose to change.

If you experience large levels of jitter and/or you know that it's caused by the first 
issue, first try increasing the Object Tracking Level (the lowest level is Standard, 
the highest is Object Tracking Only).

If it's caused by the second issue, try selecting Enable Motion Model, page 21. 
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Processing panel settings
On the Processing tab, in the Object Tracking section, the following Advanced 
parameters that relate to object tracking are displayed:

Setting Descriptions

Thread Count Number of threads to use. If set to zero (the default setting), the 
thread count is calculated automatically. Default: 0

Reprojection 
Threshold

Maximum allowable distance (in pixels) between a centroid and the 
projection of a marker into the same camera. Applies only to 
markers that are tracked using the Object Tracker. If you need to 
increase the Environmental Drift Tolerance, also increase this value.

Entrance 
Threshold

Minimum proportion of markers that must be displayed before an 
object is booted. If the proportion of markers that are displayed is 
less than this value, the object is not booted. You can override this 
value for selected objects by using object presets. Default: 1.00. 
See also Create and apply object presets, page 22.

Minimum 
Object Marker 
Separation

Minimum allowable separation distance between objects (in mm) 
to enable the objects to be tracked separately, based on the 
smallest distance between a marker on each object. Default: 10

Enable Motion 
Model

When selected, ensures stationary objects don't have a pose jitter 
arising from image noise. Select this setting to eliminate jitter that 
occurs when a scene is viewed through a stationary tracked 
camera. This setting may cause issues with very slow moving 
cameras. Default: Cleared. See also Handling jitter, page 20.  
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Create and apply object presets

Object presets enable you to specify the object tracking and smoothing 
(filtering) properties for selected objects. (Note that these properties override 
the overall object tracking properties that you can set in the Processing panel.)

By experimenting with different values for the filtering properties and applying 
them to an object using a saved object preset, you can evaluate filter 
performance to ensure the smoothest possible tracking for selected objects.

To create an object preset:

In the Tracking panel, ensure the object whose tracking and/or filtering 
properties that you want to refine is selected.

On the Properties tab below, ensure the Advanced properties are displayed 
and in the General section, on the right of the Object Preset field, click 
Manage.

In the Object Presets dialog box, enter a name for the new preset, click Add
and ensure the new preset is selected.
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Specify the required settings and close the dialog box. 
Object presets are saved in the Subjects.mcp file (found in C:
\Users\Public\Documents\Vicon\ShogunLive1.7\LastRun\UserName), or in any 
exported tracking configuration.

To apply an object preset:

In the Tracking panel, ensure that the object to which you want to apply the 
preset is selected and that Advanced properties are displayed.

On the Properties tab below, ensure the Advanced properties are displayed 
and in the General section, from the Object Preset list, select the required 
preset.
The tracking and/or filtering properties specified in the preset are applied to 
the object.

Tracking panel parameters
On the Tracking tab, with the required object (prop) selected, on the Properties
tab, the following Advanced setting is displayed:

Setting Description

Track With ObjectTracker When selected, objects are tracked using the 
object tracker. Default: Cleared
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Use Auto-Skeleton
Auto-Skeleton (AS) is an alternative to live solving subject calibration, providing 
you with a way to generate an optimized, controllable, second-solve skeleton.

Live calibration produces reliable results for accurate labeling and can produce a 
high quality solve ready for direct real-time previsualization or retargeting. Auto-
Skeleton enables you to intervene and have greater control over the solving 
subject as a post-processed alternative to the Live calibrated solve. You can re-
import the solving subject into Shogun Live so that you can use this for real time 
and also for the capture of processed data.

The way in which you use Auto-Skeleton depends on whether you have already 
created a VSS (Vicon Solving Setup file) and how much of it you want to keep:

If you have no VSS calibration, page 25

If you have a VSS and want to use its bone lengths, but calculate new 
constraint offsets, page 26

If you have a VSS but want to replace it entirely, page 28

When using Auto-Skeleton, note these points:

In these sections, the marker set used is assumed to be one of the standard 
marker sets that are supplied by Vicon.

Auto-Skeleton is compatible with VRA (Vicon Remarkable Actions) and does 
not affect it. 

Auto-Skeleton removes all solving parameterization because it's not used by 
Auto-Skeleton. It sets bone lengths and constraint offsets directly.

You can run Auto-Skeleton on an existing setup, for example, one previously 
calibrated in Live. However, with files earlier than Shogun 1.5, before you use 
Auto-Skeleton, you may need to replace the existing template by loading the 
equivalent template from 1.5 or later, if available.

For further hints and tips, see Get the best results from Auto-Skeleton, page 33.
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If you have no VSS calibration
In Shogun Post, load a ROM or at least a labeled T- or A-pose.

In the Subject Setup panel, click the Solving tab, and then the Actor Setup
tab.

Set the current frame to a good T- or A-pose.

Choose a template VSS and skin. If no templates are displayed, ensure the 
path to the templates is added in the Preferences dialog box.

Ensure Use Auto-Skeleton is selected.

Click the AS Calibrate button. 
The skeleton is scaled and posed,

If necessary, adjust any settings that require refinement (see Adjust Auto-
Skeleton results, page 30).

Solve and review the motion.

When you're happy with the result, export the VSS.
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5.

If you have a VSS and want to use its bone lengths, but 
calculate new constraint offsets

In Shogun Post, load a ROM or at least a labeled T- or A-pose.

In the Subject Setup panel, click the Solving tab, and then the Actor Setup
tab.

Set the current frame to a good T- or A-pose.

in the Subject Setup panel toolbar, click the Import Solving Setup button 
and load your VSS.

Ensure Use Auto-Skeleton is selected.
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10.

 

To the right of the AS Calibrate button, click the Show options ellipsis (...) and 
select Use Existing Bone Lengths.

Click the AS Calibrate button.
In the 3D Scene, the skeleton is posed.

Make any adjustments necessary (see Adjust Auto-Skeleton results, page 30).

Solve and review motion.

When you're happy with the result, export the VSS.
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1.

2.

3.

4.

If you have a VSS but want to replace it entirely
In Shogun Post, load a ROM or at least a labeled T- or A-pose.

In the Subject Setup panel, click the Solving tab, and then the Actor Setup
tab.

In the Subject Setup panel toolbar, click the Remove Solving Setup button 

 to remove the existing setup.

Follow steps 3–9 in If you have no VSS calibration, page 25.
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Use a VSS created with Auto-Skeleton in Shogun Live
Auto-Skeleton is just an alternative way to create a VSS for an actor. After 
running Auto-Skeleton, you can export the resulting VSS and use it in Live.

Because Auto-Skeleton removes parameterization, you can't recalibrate the VSS 
in Shogun Live. If you want to do this, go back to Shogun Post and re-run Auto-
Skeleton on a T-pose containing the new marker positions and ensure that the 
Use Existing Bone Lengths option is selected.

Auto-Skeleton is compatible with VRA (Vicon Remarkable Actions) and does 
not interfere with it.

Because solving parameterization is not used by Auto-Skeleton and it sets 
bone length and constraint offsets directly, Auto-Skeleton removes all solving 
parameterization.

You can run Auto-Skeleton on an existing setup, for example, a setup 
previously calibrated in Live. However, with files earlier than Shogun 1.5, 
before you use Auto-Skeleton, you may need to replace the existing template 
by loading the equivalent template from 1.5 or later, if available.
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1.

Adjust Auto-Skeleton results
Applying Auto-Skeleton generally produces good results. However, sometimes, 
due to marker placement or the actor's stance being less than ideal, you need to 
make some adjustments, for example, altering the pose or length of a few bones. 
Sometimes the adjustments themselves are small, like rotating the root a few 
degrees to face the right way, but this then requires the limbs be re-posed, 
which is time consuming and challenging to do manually.

Auto-Skeleton re-posing provides a solution for this. It enables you to re-pose 
only the arms, or only the legs, leaving the rest of the body as is. Re-posing 
changes only the pose. It does not adjust scale. The tools for re-posing the 
results of Auto-Skeleton are found in the same place as the Auto-Skeleton 
option: in the Subject Setup panel, on the Solving tab, click the Actor Setup tab.

Correct a misalignment of the root
In the following example, based on a T-pose, the root has ended up facing 
slightly to the actor's left side, instead of straight ahead. This can be clearly seen 
by the direction of the Z (blue) axis of the manipulator when the root is selected.

To correct the issue, rotate the root about its up axis to be correctly posed.

This leaves the arms and legs needing to be re-posed.
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2. Click the Re-pose Arms and Re-pose Leg buttons (the order does not matter 
in this case).

The arms and legs are re-posed and all constraint offsets of the entire body 
are updated based on the resulting pose.
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Re-pose fingers
In cases where you manually tweaked the arm and then need to repose the 
fingers, use the Re-pose Fingers Only button. 

Note that you need to update the constraint offsets for the arm after your tweaks 
and before you click Re-pose Fingers Only.
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Get the best results from Auto-Skeleton
The following suggestions produce best results for Auto-Skeleton and are 
generally useful, regardless of how you set up the solve.

Actor stance, page 33

Marker placement, page 34

A- vs T-pose, page 35

Single frame vs ROM, page 35

Actor stance

At the time Auto-Skeleton is run, the actor must be in a T- or A-pose.

Legs must be in a natural, neutral stance:

Feet must be about shoulder width apart.

Feet must point forward (slightly out is OK, symmetry matters most).

Feet must be in the same position forward and backward.

Legs must be straight.

Waist to head must be relaxed, natural, and straight.

Feet, waist, chest, and head must all point forward. Prevent actors from 
standing with a slight twist if they're looking off to the side watching how to 
perform the ROM. Auto-Skeleton cannot tell if the head is not pointing 
straight ahead as opposed to the markers being placed inaccurately, so it 
assumes the head is straight.

The root is assumed to be over the mid-foot, probably a little in front of the 
ankle. This is usually how people stand when relaxed. Prevent actors from 
standing too stiff and straight and leaning back, or putting too much effort 
into just standing and leaning forward.

Arms must be straight.

Fingers must be straight.
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Marker placement

Mid-segment markers (thigh, shin, bicep, and forarm) are ignored.

Root position front-to-back and to some extent side-to-side works best when 
the waist markers are symmetric. 

Aim for the waist markers to be close to all the same height. Often back is 
higher than front, which is OK, but avoid extremes.

Waist marker height overall is mostly ignored by Auto-Skeleton. Try to place 
waist markers well, but be aware that Auto-Skeleton assumes that waist 
marker height is not a reliable way to determine anything.

Place the outer knee marker so that it's on the side of the knee joint and 
symmetric in placement for both legs (same height and middle of knee front-
to-back on both left and right).

Inner knee marker is ignored.

Upper knee marker in the Production marker set is ignored.

Place ankle markers as closely as possible to the ankle joint center, but note 
that Auto-Skeleton ignores their height.

Ideally, MT markers should be at the same height and their midpoint defines 
where the toe joint ends up, as well as the height of the foot.

Toe and heel should be centered and ideally at similar height.

Place CLAV, STRN, C7 and T10 in the center of the body. Auto-Skeleton 
ignores their height, but partially uses them for actor-facing direction.

Ensure that the front and back shoulder markers are symmetric left-to-right 
and front-to-back, and that a line from front-to-back is close to intersecting 
the shoulder joint center.

Place the outer elbow markers on the sides of the joints. 

If present, place inner elbow markers on the side of the joint, symmetrically to 
the outer.

Place wrist markers so that their midpoint defines the wrist joint center. Auto-
Skeleton assumes this for both arm scale and arm posing, and correct wrist 
joint calibration is essential for the fingers to solve well.

Head markers are ignored by Auto-Skeleton. It assumes that the actor is 
standing straight, with the head looking forward.
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A- vs T-pose
Auto-Skeleton works with an A- or T-pose. The T-pose may give slightly better 
results because it assumes the clavicles are straight, whereas with an A-pose, it 
estimates the appropriate bend downward.

Single frame vs ROM
Auto-Skeleton looks only at the marker positions at the current frame. You need 
only a T- or A-pose to run it, but having a ROM present is useful to check 
whether the resulting calibration solves well.
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1.

2.

Create a subject calibration hotspot
To avoid having to clear the volume whenever you need to calibrate or re-
calibrate a subject, you can use visualize the reconstruction volume and set aside 
a part of the volume (known as a hotspot) specifically for subjects to perform 
their calibration ROMs, leaving the rest of the volume free.

Before you begin, ensure you have completed the usual setup steps, including 
camera calibration, as described in Getting started with Vicon Shogun.

To view the default reconstruction volume and subject calibration hotspot:

In Shogun Live, in a 3D Scene view, display the View Filters and ensure that 
Reconstruction Volume is selected, as well as any other options you want.

At the top of the view pane, click the Reconstruction Volume Manipulator 
button.
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3. The boundaries of the reconstruction volume (gray) and subject calibration 
hotspot (red) are displayed in the 3D Scene view.
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1.

To modify the reconstruction volume:

If you want the reconstruction volume to match the current floor extents, in 
the Camera Calibration panel, display the Advanced properties, ensure the 
Update Reconstruction Volume checkbox is selected (click the ellipsis (...) 
next to Set Floor Extents to check) and then click Set Floor Extents.
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2.

•

•

Specify the size of the reconstruction volume (gray) in either of these ways:

Drag the gray arrows, which turn yellow on selection, to change the 
boundaries. 
To move the position of the whole reconstruction volume, drag the gray 
diamond shape from the origin.
Or

On the Processing tab, ensure the Advanced properties are displayed and 
in the Reconstruction section, change the values of Volume Min X, Y, and Z
and of Volume Max X, Y and Z to reflect the required volume size and 
position.
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1.

•

•

2.

To modify the subject calibration hotspot:

In a similar way as the reconstruction volume, you can specify a subject 
calibration hotspot (red).

Specify the size of the hotspot in either of these ways:

Drag the red arrows (which turn yellow on selection) to change the 
boundaries. To move the position of the whole hotspot area, drag the red 
diamond shape from the origin.
Or

In the Tracking panel, on the Setup tab, ensure the Advanced properties 
are displayed and at the bottom, in the Reconstruction section, change the 
values of Volume Min X, Y and Z, and Volume Max X, Y and Z to reflect the 
required subject calibration hotspot size and position.

The results of your changes are displayed in the 3D Scene.
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3. If required, move the subject calibration hotspot to a different part of the 
volume either by dragging the red diamond shape or by amending the 
Volume Min X, Y, and Z and of Volume Max X, Y and Z values in the 
Calibration Processing Parameters of the Tracking panel.
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Run Shogun processing on multiple 
machines

Shogun Live’s multi-machine capability enables you to reduce dropped frames 
by running a standalone agent on one or more other machines on the same 
network.

Requirements for multi-machine processing, page 43

Set up multi-machine processing, page 44

See also:

 Vicon Shogun 1.3 Live Tutorial - Multi-machine Workflow5 on YouTube.

https://youtu.be/41bv18ULhAQ
https://youtu.be/41bv18ULhAQ
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Requirements for multi-machine processing

Agent machines with high clock speeds

Agent(s) and main machine running on the same network

Network adapters on the network set within the range 192.168.128.###

If required, for example, if 192 is already used for other clients or processes, you 
can manually set the subnet to be used for Shogun multi-machine processing. 
For details, see Specify the subnet for multi-machine processing, page 46.

1.

2.

Port numbers 
Normally, you will not need to change the default port number, 37415. 
If this clashes with another application:

Run ShogunAgent --port=<port number>

Set the matching number in the Add Agent dialog box.


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1.

2.

3.

4.

5.

6.

Set up multi-machine processing
On the main machine, note or set the IP address. In the following example, 
the address is 192.168.128.100. 

 

On the agent (secondary) machine, note or set the IP address. In this 
example, it is set to 192.168.128.101.

Open up CMD/PowerShell and ping each machine to make sure there is a 
connection.

On the agent machine, install the agent installer (the ShogunAgentInstaller
file, found in the Shogun installer) and run it.

Install the same version of Shogun on the main machine and run it.

On the main machine, in Shogun Live, on the View menu, select Agents.
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7.

a.

b.

c.

8.

In the Agents dialog box, click Add Agent 

In the first field, enter a unique name.

In the Endpoint field, enter the agent’s IP address, for example, 
192.168.128.101:

 

Click Add Agent.
At the bottom of the Agents dialog box, Contributing is displayed.

In Shogun Live, on the Processing panel, ensure the Advanced properties are 
displayed, scroll to the Multi-machine section and enter the name you 
specified (see Step 7a) of the agent(s) that you want to use for reconstruction, 
labeling, solving and/or retargeting.
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1.

2.

Specify the subnet for multi-machine processing
If required, you can manually set the subnet to be used for Shogun multi-
machine processing.

To specify the subnet:

On the main PC, add this flag:

ShogunLive.exe --agent-host-ip=HOST_IP

On the agent machine, add this flag:

ShogunAgent.exe --agent-host-ip=HOST_IP

Where HOST_IP is the IP address of the machine.

For example:

 ShogunLive.exe --agent-host-ip=192.168.1.100

When you add an agent in Shogun Live, you can then use your local IP range.
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1.

Visualize camera coverage
At any point during your use of Shogun Post, you can use the Volume Visualizer 
to visualize camera coverage of real or virtual volumes based on the cameras in 
the scene.

The tool draws voxels for each theoretical ray intersection of cameras in the 
scene. This means that, within a box encompassing all cameras, every X distance 
from one corner to the opposite corner a box is drawn if cameras can see that 
position in space. You can configure the number of cameras that need to see 
that position and change other options to customize the visualization to more 
accurately represent your setup.

 For more information, see the following steps or watch Vicon Shogun 1.3 
Post Tutorial - Volume Visualizer6 on YouTube.

To use the Volume Visualizer:

Either load a camera calibration file (.xcp), or create cameras (on the Objects
ribbon, click Create Object) or a create camera objects via a script.

https://youtu.be/TqEL34lF-ng
https://youtu.be/TqEL34lF-ng
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2.

3.

On the ribbon, click Camera Calibration and in the Camera Calibration panel, 
click the Volume Visualization tab.

 

Select whether to show camera frustums and set the other options as 
required (see Volume Visualizer settings, page 50) and then click Visualize 
Volume.
The volume, with colored voxels representing the area seen by the selected 
camera(s), is displayed. 

 

Each box shows a position where cameras intersect. With the default (Jet) 
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4.

color map selected, the lighter boxes are where three cameras (the default 
Min Cameras Per Voxel setting) intersect, and as the boxes become red, more 
cameras are intersecting. By rotating around this view, you can see which 
areas of the volume have the best coverage, whether there are dead spots, 
where you get the most height, etc.

If necessary, adjust the settings to enable you to visualize the volume as 
required (see Volume Visualizer settings, page 50).
You can use the Manipulator tool in the 3D Scene view to move and rotate 
cameras and observe the effect on the volume coverage. Note that increasing 
the voxel size can improve performance.
You can also add cameras (on the Objects ribbon, click Create Object), 
delete cameras, or change the type of a camera (from the Attributes editor), 
etc. This enables you to visualize not just existing calibrated camera 
configurations but also virtual camera arrangements, so you can try out new 
camera configurations.
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Volume Visualizer settings
The following options are provided for volume visualization:

Option Description

Enable 
Coverage 
Frustums

Displays or hides the Draw_Frustum attribute of all the cameras. The 
Visualize Volume tool uses this attribute to determine how far each 
camera can theoretically see.

You can display a camera's frustum in Shogun Post without using 
Visualize Volume. To do this, select one or more cameras and in the 

Attributes editor, display the Advanced options ( ) and in the 
Display section, select the Draw_Frustum attribute. It's drawn as a 
transparent pyramid extending from the camera. This is another way 
of visualizing the space a camera can see and can be useful on its 
own or with the Vizualize Volume tool.

Auto Set 
Volume Limits

If selected, the box containing the voxels automatically includes all 
the cameras in the scene and clamps it to the floor.

Min X, Min Y 
and Min Z

Defines the volume size (mm)

Voxel Size Modifies the spacing between boxes. A lower value draws more 
voxels, but may take longer to draw (default is 750).

Box Size The size of the box that is drawn at each voxel (1-1000, default is 50 
mm)

Min Cameras 
Per Voxel

The minimum number of cameras that must see a voxel for it to be 
drawn. Usually, set this value to the fewest ray intersections 
acceptable to reconstruct a marker as a starting point.

Max Cameras 
Per Voxel

The maximum number of cameras that must see a voxel for it to be 
drawn. Usually, set this value to the number of cameras in the scene.

Auto Set Max 
Cameras Per 
Voxel

If selected, automatically sets the maximum number of cameras per 
voxel to the number of optical cameras in the scene.

Color Map Lists the color schemes available to show the number of cameras 
that see each voxel.
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Option Description

Filter 
Operation

By default the tool works on all cameras, but this setting lets you 
display voxels based on the selected cameras.
None Shows all the voxels seen by all cameras, regardless of which 
cameras are selected.
All Selected Shows only the voxels seen by all the selected cameras.
Any Selected Shows voxels seen by any of the selected cameras.
None Selected Shows voxels that are not seen by the selected 
cameras.
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Set up SDI video cameras
In Shogun Live 1.5 and later, you can include up to four SDI video cameras
(including sound) in your Vicon Shogun system.

When you have calibrated the SDI video cameras, you can overlay the motion 
capture data and check the solve against the video. You can also export the 
calibrated cameras with the image sequence directly into Autodesk® Maya® 
software as an FBX file. 
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The following sections describe how to set up SDI video with a single Blackmagic 
URSA Mini 4K camera and an Evertz 5601MSC timecode generator, but the same 
principles apply to other supported hardware.

Recommended SDI video hardware, page 54

Set up a capture card for SDI video in Shogun Live, page 64

Set up a timecode generator for SDI video in Shogun Live, page 72

Set up cameras for SDI video in Shogun Live, page 85

Check and connect the SDI video system components, page 103

Choose shutter duration, video standard and system frame rate, page 106

Calibrate the SDI video system, page 111

  For details about this procedure, watch the Vicon video, Shogun Live SDI 
Video7, available on YouTube.

 The Vicon video, Shogun Live SDI Video8, is also available on Vimeo.

Shogun Live lets you link a calibrated SDI or Vicon Vue video reference camera 
to a rigid tracking object. This enables the video camera to be tracked, providing 
real-time 3D overlay in Shogun Live while the camera is moving and enabling the 
animation to be captured to the MCP. For more information, see Link a prop and 
a video camera, page 9.

Note 
As the videos were recorded using an earlier version of Shogun, you 
may notice minor differences in the user interface.



https://youtu.be/X-GiJ9bHAvY
https://youtu.be/X-GiJ9bHAvY
https://vimeo.com/275782939
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Recommended SDI video hardware
In Vicon Shogun Live 1.2 and later, you can display and capture video from SDI 
video cameras. This enables you to use a huge range of third-party, professional-
quality video cameras to overlay and capture calibrated reference video. 

The following recommendations are based on what the software supports for 
calibration and what has been tested with this version of the software. They are 
provided to help you to choose the most suitable SDI hardware.

Recommended cameras for calibrated video, page 55

Suitable cameras for uncalibrated reference video, page 57

Recommended capture cards, page 58

Recommended timecode embedder, page 60

Recommended master clock/SPG/timecode generators, page 61

Recommended cabling, page 63
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Recommended cameras for calibrated video
For a camera to work well with Vicon Shogun it must:

Have a global shutter sensor.

Be able to output progressive video (eg, 720p, 1080p). Interlaced video (eg, 
625i/PAL, 525i/NTSC, 1080i) is not supported.

Support a genlock/reference/sync input.

Have a timecode input and support embedding timecode in the video, or else 
you will need a separate timecode embedder.

Produce output that is compatible with a Blackmagic DeckLink capture card. 
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Following testing, Vicon recommends these cameras for calibrated reference 
video:

Camera SDI 
outputs 

Global 
shutter
 

Genlock/
Reference 
sync

Timecode 
input

Timecode 
embedded 
in output

Highest 
supported video 
standard

RED Komodo 

6K1
1 x 12G 2160p/60

Blackmagic 
URSA Mini 4K 

(discontinued)2

1 x 12G
1 x 3G

2160p/60 

ARRI Alexa Mini 
LF

1 x 6G 4 2160p/30

IO Systems 

Flare 2KMSDI-B3
2 x 3G 1080p/30

1. For timecode and genlock, the Komodo Expander Module9 is required.

2. Only LTC timecode is supported. When LTC timecode is used, only the SDI 
reference signal can be used (ie, not tri-sync). 
Set Reference Input on camera to Program and check for REF and EXT on screen 
overlay.

3. This is a grayscale sensor. A timecode embedder is required.

4. Rolling shutter, but tested and found to be fast enough in most cases. 

Blackmagic URSA Mini 4.6K 
The Blackmagic URSA Mini 4.6K uses a different sensor that is not global 
shutter, so is not recommended.



https://www.red.com/komodo-expander-module
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Suitable cameras for uncalibrated reference video
The following camera has been used for capturing reference video in Shogun 
Live, but because it has a rolling shutter sensor, it can't be used for calibration:

Camera SDI 
outputs

Global
shutter

Genlock/
Ref. 
sync

Timecode 
input

Timecode 
embedded
in output

Blackmagic 
Micro Studio 
4K 
(discontinued)
1

1 x 6G

1. SDI reference is supported. A timecode embedder is required.
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Recommended capture cards
Shogun Live supports capturing from Blackmagic DeckLink cards using the 
DeckLink API, thus any DeckLink card should work with it. In addition, Shogun 
Live 1.6 and later includes support for the two Bluefish444 SDI video capture 
cards listed at the bottom of the following table. 

Vicon has tested Shogun Live with the following cards:

Manufacturer Model No. of 
inputs

Notes

Blackmagic 
Design

Decklink 8K 
Pro

4 x 12G Recommended for 
12G and multi-camera 
captures. The host PC 
must be powerful 
enough to support 
multi-camera capture. 
In particular, it must 
have enough fast 
drives.

Decklink 
Mini 
Recorder 4K

1 x 6G Recommended as a 
cost effective option 
for setups where 12G 
is not required.

Decklink 4K 
Pro

1 x 12G

Decklink 4K 
Extreme 
12G

1 x 12G

DeckLink 
SDI 4K

1 x 6G
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Manufacturer Model No. of 
inputs

Notes

DeckLink 4K 
Extreme

1 x 6G

Bluefish444 Kronos K8 8 x 3G Supported as either 8 
independent 3G 
inputs or 4 x 3G inputs 
for quad-link video.
8 x small-size BNC 
ports.

Epoch | 4K 
Neutron

3 x 3G Supported as 3 x 3G 
inputs.
An optional LTC 
expansion module is 
available.
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Recommended timecode embedder
We have tested the following timecode embedder:

Timecode embedder Number of 
channels

Notes

Blackmagic Teranex 
Mini Audio to SDI

1 x 12G Use right XLR audio input to insert LTC 
timecode, and select Timecode mode in 
control software.
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•

•

•

•

•

•

•

•

•

•

Recommended master clock/SPG/timecode generators
We have tested the following timecode generators:

Timecode generator Notes

Evertz 5601 If the camera requires SDI sync (eg. Blackmagic URSA) then 
the Evertz 5601 must have a suitable HD or 3G SDI TG (Test 
Generator) option. The options are known as +HDTG and 
3GTG. The presence of the options is not apparent from 
the number of connectors (ie, the connectors can be 
present even if the option is not included). To determine 
which options are enabled, go to the Status tab in VistaLink. 
In the Options group, ensure that the TG option is present, 
ie, it displays HD Present or 3G Present rather than Not 
Valid.
Typically the following connections are required:

LTC 1, 2 (XLR): Provide LTC for SDI camera or 
timecode inserter.

TG 1, 2 (BNC): Provide SDI sync if SDI camera 
accepts this, or

Sync 1, 2, 3, 4, 5, 6 (BNC): Provide Tri-Sync or 
Blackburst if camera accepts this.

Sync 1, 2, 3, 4, 5, 6 (BNC): Can be configured to 
supply PAL/NTSC sync with VITC to Lock/Lock+, or

TG 1, 2 (BNC): Provide SDI sync to Lock Studio.

Courtyard CY440
LTC/Wordclock: May be configured to provide LTC 
output.

SDI 1, 2 (BNC): Provide SDI sync to camera, or

Tri/Black 2, 3, 4: Provide tri-sync to camera

Composite (BNC): Provides PAL/NTSC sync with 
VITC to Lock/Lock+, or

SDI 1, 2 (BNC): Provide SDI sync to Lock Studio
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•

Timecode generator Notes

Courtyard CY460 Typically the following connections are required:

Balanced Audio/AES/LTC (Molex): May be 
configured to provide LTC output. Custom cable 
required.

SDI 1, 2 (BNC): Provide SDI sync to camera, or

Tri/Black 2, 3, 4: Provide Tri-sync to camera

Composite (BNC): Provides PAL/NTSC sync with 
VITC to Lock/Lock+, or

SDI 1, 2 (BNC): Provide SDI sync to Lock Studio
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Recommended cabling
SDI video uses co-ax cable with 75Ω characteristic impedance.  Cables labeled 
RG-59U will be 75Ω, but may not be of sufficient quality for 3G video.  Good 
quality cables with low return-loss are very important, and become even more 
crucial over longer distances and at higher standards, such as 6G and 12G. SDI 
sync also requires good quality video cable because it is also an SDI video 
signal.  Analog blackburst, tri-sync and LTC signals are likely to be more 
forgiving.

We have tested the following cable types:

Cable Notes

Belden 1694A This is sometimes said to be industry-standard video cable. 
This was used for testing up to a range of 30 m for 3G and 
20 m for 6G.

Van Damme 
278-175-000 LSZH

20 m lengths of this were used for 3G and 6G.
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•

Set up a capture card for SDI video in Shogun Live
These cards are supported for SDI video in Shogun Live 1.6 and later:

Set up a Blackmagic DeckLink card, page 65

Set up a Bluefish444 card, page 67
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1.

2.

3.

4.

5.

Set up a Blackmagic DeckLink card
Install the capture card in your computer. Remember to connect its extra 
power connector if it has one.

Download and run the Blackmagic Desktop Video Installer, which includes the 
drivers.

 Note 
We recommend that you use version 12.1 or later of the Blackmagic Desktop 
Video Installer. Earlier versions may not work with Shogun Live.

Open Shogun Live and ensure that in the System panel, the card is listed 
under Video Inputs.

 

If the device isn't listed, the capture card could be incorrectly installed, the 
correct driver could be missing, or another instance of Shogun Live could be 
running and using it.

Ensure that the card is selected and in the Information section of the 
Properties, note that Video Standard is set to Unspecified. 
This indicates that the cable is not connected or there's no signal on it.

  

Identify which BNC connector is the video input. Some cards have multiple 
inputs that are not labeled, so you may need to refer to the Blackmagic 
documentation. 
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6. Connect this input to the SDI output from the camera. 
In the Properties, the icon changes in the Video Inputs section.

 

In the Information section, the Video Standard is now displayed.

 

If the video standard is not shown, the standard may not supported by the 
capture card, or there may be a problem with the camera or the cabling. 
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1.

2.

3.

4.

5.

6.

7.

Set up a Bluefish444 card
For supported cards, see Recommended capture cards, page 58.

Install the card following the instructions in the manual.

Note that Shogun Live requires version 6.3.3.1 or later of the drivers. 
Download the Bluefish444 driver installer from the Bluefish444 website10.

Run the installer in administrator mode, ensuring that utilities and drivers are 
selected.

To configure card for inputs, press the Windows key and enter 
BlueFirmwareUpdater. Follow the instructions to configure the card for 
inputs (eg, 3 inputs for the Epoch 4K Neutron or 8 inputs for the Kronos K8).

 Important 
Ensure that you completely power down the computer after a firmware 
update. It is not sufficient to just reboot.

Power down the computer.

Start Shogun Live.

Check that the card has been detected on start-up. If it is detected, a 
message similar to this is displayed in the log:

 

If a warning like the following appears in the log instead, it probably means 
that the driver is not properly installed:

 

https://bluefish444.com/support/downloads/details/1/bluefish444-windows-installer.html
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1.

2.

3.

4.

In the the System panel, go to the Video Cameras section of and check that a 
separate entry is displayed for each camera:

 

Configure for quad-link

If you want to use quad-link mode on the Kronos K8:

Connect four 1.5G or four 3G signals to inputs A, B, C and D, or inputs E, F, 
G, and H.

Confirm that you can see four separate video streams in the Shogun Live 
workspace. Note that each one is receiving a 1.5 G or 3 G standard.

 

In the System panel in Shogun Live, in the properties pane, click Show 
Advanced to display the advanced parameters.

Change input A or E from SingleLink to QuadLink mode. (Inputs B,C, D, and 
F, G, H will not have this option.)
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•

After you have changed the relevant input to QuadLink, inputs B, C and D; or 
F, G, and H disappear, and input A or E now reports receiving a 2160p 
stream.

About quad-link mode

Quad link Mode provides these options:

In Square Division Quad Split mode, the image is divided into quarters and 
each is transmitted on a single 3G link.

In Two Sample Interleave mode, alternate pixels are divided between image, 
so each stream has a full image effectively subsampled.

Both modes enable the full original image to be reconstructed without loss of 
data.

Shogun Live cannot determine which type of quad-link mode is in use, so you 
must select the correct mode.
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The selected option takes effect immediately. If you choose the wrong option, 
the video will appear obviously wrong:

Original image

When Two Sample Interleave is 
incorrectly treated as Square Division 
Quad Split, it will appear as four copies 
of the video tiled together.

When Square Division Quad Split is 
incorrectly treated as Two Sample 
Interleave, all four quarters of the video 
appear to have been superimposed on 
top of each other.

Note 
In Two Sample Interleave mode, Luminance8, BGRA, RGBA, and 
U10Y10V10Y10 pixel formats are not supported. We recommend using 
U8Y8V8Y8 mode instead.


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Use External LTC extension

If you have an LTC extension board, you can make available the timecode that 
this provides by setting the Timecode Source to External LTC.

Known Limitations

3G Level-B Dual link mode is not supported on either card.

4:4:4 RGB mode is not supported on either card.

Both Quad Division and Two Sample Interleave mode are supported, but in 
Two Sample Interleave mode, not all pixel formats are supported.
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Set up a timecode generator for SDI video in Shogun 
Live

These timecode generators (SPGs) are supported for SDI video in Shogun Live 
1.6 and later.

Set up a Courtyard CY440 timecode generator, page 73

Set up an Evertz 5601MSC timecode generator, page 81
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1.

2.

3.

Set up a Courtyard CY440 timecode generator
You can set up the Courtyard CY440 to provide reference and timecode to both 
the SDI camera and the Vicon system. Most SDI cameras require two cables to 
provide both timecode and sync.  In the case of SDI and Composite, Vicon Lock 
units can accept one cable that carries both reference sync and timecode. 
However, when tri-level sync is used, LTC timecode is also required.

Consequently, either three or four ports on the timecode generator are used: 
two to the camera, and either one or two to the Lock unit. If multiple cameras are 
used, then you may need to add distribution amplifiers for LTC, and for either tri-
sync or SDI.

The software used to set up the Courtyard timecode generator is ROSS 
DashBoard11. It can be freely downloaded and installed on Windows.

To set up the timecode generator:

If the SDI feature is required to sync the camera or the Lock unit, check that it 
is enabled.

On the front panel, select System Setup > Option Enable. 
If SDI is present, HD and 3G are listed, together with an option code for each.
The SDI feature is required for cameras that require SDI sync, such as the 
Blackmagic URSA Mini 4K, and if you want to use the SDI input on a Vicon 
Lock Studio.

Find the IP address of the device using the front panel, or set an IP address. 
The IP address is shown on the front panel of the device when the menu is 
not in use. 
If you need to change any network settings, go to System Setup > Network. 

https://www.rossvideo.com/support/software-downloads/dashboard/
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4.

5.

Use the Ross Dashboard software to add a connection to the device.

If the connection succeeds, the new display is added to the tree view in 
green, with sub-menus below it. 
If it is not found, it is added to tree in gray, with no sub-menus under it.

On the System Time menu, set the frame rate for the LTC signal to the video 
camera, and a Lock is required.  
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You must set the frame rate to the base rate associated with the desired 
video standard on the camera. For example, for 60 Hz video standards, the 
timecode frame rate is 30 Hz.

The CY440 has only one LTC generator, to provide timecode to the SDI 
camera and the Vicon system. Two outputs on the CY440 can be used for 
LTC. We recommend that you set them both to LTC1. 
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This gives two timecode outputs: one for the camera and one for the Vicon 
Lock unit (if required, as the Lock can also get timecode from Composite, or 
SDI in the case of a Lock Studio.)

The outputs on the CY440 that can be configured for LTC are labeled LTC 
and Wordclock. 
Connect one of the LTC outputs to the video camera and one to the Lock 
unit, if the Lock is using tri-sync and LTC. (If a Lock Studio is getting an SDI 
signal, or any type of Lock is getting a composite signal for sync, then the 
embedded timecode in the signal can be used and a separate LTC 
connection is not required.)
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6.

•

Set up the reference signal for the camera. This must be the same as the 
video standard that is selected on the camera.

For cameras that take SDI reference, such as the Blackmagic URSA Mini 4K, 

page 92, use Slot 1: SDI 1 Video.

Then connect the output labeled SDI1 to the camera's SDI IN port. 
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• For cameras that take tri-sync reference, such as the ARRI Alexa Mini LF, 

page 95, use Slot 8: Color Black 2.

Connect the output labeled Tri Black 2 to the cameras SYNC IN port. 
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7.

•

Set up the timecode and sync for the Vicon Lock unit.

Vicon Lock or Lock+
Use Slot 9: Color Black 3 and set the video format as required.

Connect the output labeled Tri Black 3 to the Lock's REF LOOP port. 
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• Vicon Studio
Set the SDI output as shown in step 6. The CY440 can generate only one 
type of SDI signal at a time, although it has two physical BNC connectors, 
labeled SDI 1 and SDI 2.
This means the standard chosen must be suitable for syncing both the Lock 
and the SDI. If there is no suitable SDI standard, the Lock must be synced 
from the CY440, using either tri-level or composite. If tri-level is used, LTC is 
required for timecode because tri-level sync does not include timecode.
You can configure independently whether the two outputs are black or 
show a test pattern, but this is usually irrelevant for sync and timecode. 
Make sure that embedded timecode is enabled. This is described as ATC in 
the software and must be set to LTC.

Connect SDI 2 to the Lock's SDI port.

29.97 Hz non-drop frame
Some older versions of the Courtyard firmware do not support 29.97 Hz 
timecode in non-drop-frame mode. For more information, contact 
Courtyard.





B E Y O N D  M O T I O N

Set up SDI video cameras

12 https://evertz.com/solutions/vistalink

Getting more from Vicon Shogun

05 October 2021

Page 81 of 148

1.

•

Set up an Evertz 5601MSC timecode generator
You can set up the Evertz 5601MSC to provide reference and timecode to both 
the SDI camera and the Vicon system. The URSA Mini 4K always requires two 
cables to provide both timecode and sync. The Vicon system requires one cable 
that can carry both reference sync and timecode.  Consequently, at least three 
connections on the timecode generator are used.

VistaLINK PRO12 software is used to control the timecode generator.

To set up the timecode generator:

Check that the Evertz 5601MSC has a suitable HD or 3G SDI module. These 
modules are known as +HDTG and +3GTG by Evertz. To check that the 
correct module is selected:

In VistaLink, go to the Status panel and in the Options group ensure that 
the TG option is HD Present or 3G Present. 

 

If the TG option is Not Valid, upgrade your Evertz 5601MSC to include the 
HD or 3G SDI modules.

https://evertz.com/solutions/vistalink
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2.

3.

Set the frame rate for the timecode signal (LTC) for the URSA camera. This 
must be set to the base rate associated with the desired video standard on 
the camera.  For example, for 59.94 Hz video standards, the timecode frame 
rate is 29.97 Hz. 

Set up the SDI reference signal for the camera. This must be the same as the 
video standard that is selected on the camera.
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4.

•

•

Set up the timecode reference to the Vicon Lock unit. The connection to use 
depends on your Vicon Lock model:

Vicon Lock or Lock+ : Use one of the SYNC outputs from the timecode 
generator.  Lock or Lock+ supports only analog black-burst sync with VITC. 
This means that only base rates of 25 Hz (PAL) or 29.97 Hz (NTSC) are 
available (for true 30 Hz, use a Lock Studio). Choose either PAL or NTSC-M, 
to match the base rate of the SDI video standard. 

 

Vicon Lock Studio: Use one of the SDI TG-x outputs on the timecode 
generator.  Lock Studio supports HD-SDI with embedded timecode. Ensure 
that the settings match those you specified in step 2 for the camera.
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Drop frame setting 
Shogun Live supports 29.97 Hz timecode in drop-frame or non drop-
frame mode. However, the drop-frame setting must be consistent 
between all three outputs on the timecode generator.


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•

Set up cameras for SDI video in Shogun Live
These cameras are supported for SDI video in Shogun Live 1.6 and later:

Set up a RED Komodo camera in Shogun Live, page 86

Set up a Blackmagic URSA Mini 4K camera, page 92

Set up an ARRI Alexa Mini LF camera, page 95
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•

•

•

Set up a RED Komodo camera in Shogun Live
The RED Komodo camera  is supported for SDI video in Shogun Live. Full details 
of how to set up and use the camera can be found in the Komodo Operation 
Guide13. This document includes the extra information required to set up and 
use the camera with Vicon Shogun Live.

 

Global shutter sensor, page 87

Sync and timecode, page 87

Set up the SDI output, page 90

https://www.red.com/download/komodo-operation-guide
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•

Global shutter sensor

This camera has a global shutter sensor which makes it particularly suitable for 
use with the calibrated video feature of Vicon Shogun Live.

Sync and timecode

To calibrate the camera in Shogun Live, both genlock and timecode are 
required. The camera requires the RED Komodo Expander Module to give easy 
access to genlock and timecode. Ensure this is fitted according to the 
manufacturer's instructions.

Two cables are required to connect the timecode generator to the Komodo 
Expander module: one for genlock and one for timecode.

Set up the required timecode, page 88

Set up the required genlock, page 88

Check timecode and genlock, page 88



B E Y O N D  M O T I O N

Set up SDI video cameras

Getting more from Vicon Shogun

05 October 2021

Page 88 of 148

1.

2.

•

•

•

Set up the required timecode

Connect the timecode to the BNC connector labeled Timecode. 
This must be the LTC timecode from the port on the timecode generator 
labeled TC, Timecode or LTC.

On the camera's onscreen display, select Menu > Audio / TC  > Timecode 
Source and then select External.

Set up the required genlock

Tri-sync genlock is supplied to the BNC connector labeled Genlock. This must 
be tri-sync genlock from the port on the timecode generator, usually labeled 
Sync N or Tri-Black N.

Check timecode and genlock

Check these settings on the camera display:

GEN Must be green, indicating external sync is being received.

TC Must be green, indicating timecode is being received.

SYNC Must be green, indicating sensor is synced with timecode and the 
camera's output is synced with genlock.

Any other colors (gray, red, yellow, etc) indicate a setup problem, which may not 
be immediately apparent in Shogun Live but which will cause problems for 
capturing calibrated video later. For more detailed information including the 
meaning of each status color, see the Komodo Operation Guide.
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Status On-screen display Explanation

Genlock and 
timecode being 
received

Ready to 
capture in 
Shogun Live.

Genlock being 
received but not 
timecode

Fix problems 
with camera 
setup before 
capturing or 
calibrating in 
Shogun Live.

Timecode being 
received but not 
genlock

Neither timecode or 
genlock being 
received

Important 
Shogun Live does not visually indicate whether the camera is getting a 
genlock signal and cannot tell whether the camera is getting external 
timecode or generating it internally, so you must check this on the 
camera itself.


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•

Set up the SDI output

Connect the SDI output to the capture PC's capture card. If multiple outputs are 
required (eg, for a monitor), we recommend using an SDI distribution amplifier.

Set resolution and frame rate

To set the resolution for the SDI output, on the camera's onscreen display 
select Menu > Monitoring > SDI > Resolution.

To set the frame rate, select Menu > Monitoring > SDI > Frequency.

UHD and DCI 
Shogun Live supports progressive video standards up to 4K, as long as a 
compatible capture card is used.
However, it has been more rigorously tested with the UHD standards 
(1920 × 1080, 3840 × 2160) than the DCI standards (2048 × 1080, 4096 × 
2160).


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Disable onscreen displays

We strongly recommend that you disable all the monitoring features on the SDI 
output. The onscreen display can interfere with calibrating in Shogun Live, unless 
the text is masked, and if the display features are changed after calibrating, the 
calibration may be invalidated.

On the camera's onscreen display, select Menu > Monitoring > SDI. Change all 
of Guides, Tools, and Overlay to 0 (red color, meaning off).
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•

Set up a Blackmagic URSA Mini 4K camera
The Blackmagic URSA Mini 4K camera is supported for SDI video in Shogun 
Live. 

 Documentation for using all cameras in the URSA Mini range can be found in 
the Blackmagic URSA Mini Manual14.

Global shutter sensor, page 93

Sync and timecode setup, page 93

https://documents.blackmagicdesign.com/UserManuals/BlackmagicURSAMiniManual.pdf


B E Y O N D  M O T I O N

Set up SDI video cameras

Getting more from Vicon Shogun

05 October 2021

Page 93 of 148

•

•

1.

2.

Global shutter sensor

This camera has a global shutter sensor which makes it suitable for producing 
calibrated reference video in Shogun Live. 

Newer cameras in the range, the URSA Mini 4.6K, URSA Mini 4.6K G2, URSA Mini 
Pro and URSA Mini Pro 12K all have rolling shutter sensors that make them much 
less suitable for use with Shogun Live, so we do not recommend using these 
cameras.

Sync and timecode setup

The URSA Mini 4K has an unusual set of inputs for sync and timecode. A single 
connector is used for tri-sync reference and timecode (LTC) meaning that it is not 
possible to use tri-sync reference still get external timecode. There is also an SDI 
input that accepts reference SDI but ignores any embedded timecode in the SDI 
stream.

Since Shogun Live requires both genlock and timecode, the only combination of 
inputs that will allow this is:

SDI In Used for reference input

REF-IN/TC-IN Used for LTC timecode input

This means that the timecode generator must also be capable of providing SDI 
reference video. This is usually an optional extra in timecode generators, and 
older models may not have it.

To set up the camera:

Ensure that the software on the camera is version 4.9 or later. This reduces 
video latency.

From the onscreen display, choose the correct video standard.
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3.

4.

Set Reference Source to Program.

 

REF is now displayed on the camera monitor.

 

Check that timecode is working correctly. The timecode should be in sync 
with the timecode generator and EXT should be displayed above TC on the 
camera monitor. 
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•

•

Set up an ARRI Alexa Mini LF camera
The ARRI ALEXA Mini LF camera is supported for SDI video in Shogun Live.

The following topics provide information about setup and calibration. Read them 
in conjunction with the ARRI ALEXA Mini LF Manual15 (PDF download from 
arri.com).

Use of the rolling shutter, page 96

Sync and timecode, page 96

Set the required video standard, page 101

https://www.arri.com/resource/blob/176542/b9f286327d89a155c06e3cca81bf6fc6/alexa-mini-lf-sup-6-0-user-manual-data.pdf
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Use of the rolling shutter

The ARRI ALEXA Mini LF camera has a roller shutter sensor. In general, we don't 
recommend the use of cameras with rolling shutter sensors. However, the 
acceptability depends on the speed of the readout from the sensor. A good test 
is whether the calibrator detects wands during a normal fast wand wave. If it 
does, this indicates that the rolling shutter time is fast and the amount of 
distortion is unlikely to be problematic except for very fast movement.

If you are forced to use a deliberately slow wand wave to enable the calibrator to 
detect wands, it is likely the rolling shutter effect will be problematic in normal 
use.

Satisfactory results were obtained with a normal, fast wand wave with this 
camera.

Sync and timecode

The ARRI ALEXA Mini LF camera takes a separate timecode and sync/genlock 
connection. It can also extract reference sync from the timecode signal, but we 
do not recommend this mode of operation. As with all SDI video cameras, both 
sync/genlock (SYNC IN) and timecode (TC) are required for the camera to be 
calibrated in Shogun Live. The sync/genlock and timecode signal can come from 
a sync and timecode generator (SPG), such as the Evertz 5601MSC, or Courtyard 
CY440 or CY460.
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1.

Set up the required timecode

The timecode cable is used to carry an LTC signal from the sync and timecode 
generator.  At the camera end, a 5-pin lemo connector plugs into the port on the 
camera labeled TC, and at the other end is either BNC or XLR, depending on the 
type of device being used. Plug it into an LTC output on the timecode 
generator, which is usually labeled LTC or Timecode.

As usual when using timecode, set the timecode generator to provide LTC at a 
rate equal to, or exactly half the video frame rate desired, as LTC rates only go 
up to 30 Hz.

To set up the camera for timecode:

Navigate to HOME > TC > Options > Run Mode and ensure that the value is 
set to Free Run. 
In this mode, the timecode continues to count up, even when not recording 
on the camera, which is the behavior required by Shogun Live. 
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2.

3.

1.

2.

Navigate to HOME > TC > Options > Mode and ensure that the value is set 
to Regen. 
In this mode, the timecode does not sync to the input once, but keeps in 
track with it, except when the camera is recording. If the timecode generator 
is also providing sync/genlock and the standards are set correctly on both 
outputs, there should be no discontinuities in the timecode received.

 

As an additional check that the settings are correct, navigate to HOME > TC
> Options > Regen Source and ensure that LTC in is displayed.
The camera displays TC in white when it has a timecode. The timecode itself 
is also shown on the camera's display.

When the timecode is set up correctly, it is displayed in Shogun Live below the 
Vicon system timecode. In this example, it is listed as DeckLink C1, referencing 
the SDI capture card in use.

 

Set up the required genlock

The genlock cable is a BNC-to-BNC cable that is used to carry genlock from the 
timecode generator.

On the camera, plug the cable into the connector labeled SYNC IN.

Ensure the cable is connected to a tri-sync output on the timecode generator, 
and set the video standard to that required for the camera. 
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3. Navigate to MENU > System > Sensor > Genlock Sync and set the value to 
SYNC IN.

Check timecode and genlock

When timecode and genlock are being received, on the display TC in white and 
GEN in black are displayed, as shown here:

When there is a problem with timecode or genlock, the ARRI ALEXA Mini LF 
camera shows TC or GEN in amber respectively.

Important 
Check that the GEN message changes to orange when the cable is 
removed. It is important to do this to verify that the genlock input is 
being used, rather than the camera obtaining sync from timecode, 
which we don't recommend.


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Status On-screen display

Genlock / Sync In working

Genlock / Sync In disconnected or 
not working

Timecode working

Timecode disconnected or not 
working

Important 
Shogun Live does not visually indicate whether the camera is getting a 
genlock signal, so it is particularly important to check this on the camera 
itself.


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1.

2.

Set the required video standard

The ARRI ALEXA Mini LF camera supports 1.5 G and 3 G video standards on the 
outputs labeled SDI 1 and SDI 2. It supports only 6 G video standards on its SDI 
2 output.

Connect the SDI 2 output to the Shogun Live PC. If SDI connections to other 
devices are required, use a distribution amplifier. Distribution amplifiers should 
not introduce a significant delay to the signal, but we recommend that you set 
up all of the cabling before calibrating, rather than plugging and unplugging 
cables after calibration.

The camera doesn't have a direct video standard setting. The video frame rate is 
determined in the Project settings. The transport format on the SDI output is set 
in the Monitoring settings.

To change the video standard:

Navigate to HOME > FPS and use the jog wheel to choose the desired frame 
rate.

   

Navigate to MENU > Monitoring > SDI > SDI 2: Clone SDI and ensure that 
the checkbox is cleared.
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3. Navigate to MENU > Monitoring > SDI > SDI 2 Format and set it to the 
desired video transport format. For example, to enable 2160 p (4K) output, 
change SDI 2 Format to 422 6G UHD.
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Check and connect the SDI video system components
Before you begin to connect your system components, check that your hardware 
is included in Recommended SDI video hardware, page 54. For setup instructions 
for the components, see:

Set up a capture card for SDI video in Shogun Live, page 64

Set up timecode generators (SPG) for SDI video in Shogun Live, page 72

Set up cameras for SDI video in Shogun Live, page 85

Connect the SDI video system components
To ensure that the camera shutters are aligned, the SDI camera must be 
genlocked to the Vicon system. This ensures that the SDI camera reliably see 
strobes from the Active Wand.

Timecode is used to identify the time at which data from the SDI camera and the 
Vicon system was captured. This ensures that the data from the two sources can 
be aligned. The calibrator can then determine any small remaining discrepancy 
and apply an offset to the video input to correct for it.

Consequently, both the SDI camera and the Vicon system must have a valid 
genlock signal and a valid timecode. Two cables are required to transmit 
reference sync and timecode to the camera, whereas the a single cable can carry 
both reference sync and timecode to the Vicon Lock unit.

Note 
In the following instructions and except where differences are noted, 
references to Vicon Lock units apply to Vicon Lock, Vicon Lock+ and 
Vicon Lock Studio.


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1.

a.

b.

c.

2.

•

To connect the system components:

On the Blackmagic URSA Mini 4K:

Connect SDI Out to the input on the DeckLink card on the PC that will run 
Shogun Live.

Connect SDI In to TG1-2 on the Evertz 5601MSC.

Connect REF IN / TC IN to LTC OUT 1 on the Evertz 5601MSC.

Connect from the Evertz 5601MSC to the Vicon Lock unit, depending on your 
Lock model:

Vicon Lock or Vicon Lock+: Connect SYNC 1 on the Evertz 5601MSC 
to REF LOOP on the Lock or Lock+. Put a 75Ω terminator on the other REF 
LOOP connector. (Note that Lock or Lock+ can capture only PAL (25 Hz) or 
NTSC (29.97 Hz): for true 30 Hz, you must use a Lock Studio.)
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• Vicon Lock Studio: Connect TG1-1 on the Evertz 5601MSC to SDI In on the 
Lock Studio. 
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Choose shutter duration, video standard and system 
frame rate

The SDI video standard frame rate and Vicon system frame rate must both be 
multiples of the same SMPTE base rate. The SMTPE base rates are 23.98 Hz, 24 
Hz, 25 Hz, 29.97 Hz, and 30 Hz. 

As shown in the following table, it is usually best to have the Vicon system rate 
higher than the video standard frame rate, so that the Vicon cameras can 
accurately track fast movement, but so the video cameras do not produce data 
at a rate that is higher than the PC can capture.

Base rate (Hz) SDI video standard Vicon system frame rate (Hz)

24 1080p/24 (1x) 96 (4x)

25 1080p/25 (1x) 50 (2x)

25 1080p/50 (2x) 100 (4x)

29.97 1080p/29.97 (1x) 59.94 (2x)

29.97 1080p/59.94 (2x) 119.88 (4x)

When the system is set up in this way, the Vicon system strobes several times 
during each video frame.  The active wand calibration device also strobes in sync 
with the optical system, so when the wand is moving, the video camera may see 
it in more than one place during each video frame.  For this reason the shutter 
duration must be set within a particular range:

If the shutter duration is set too low, the camera may not see the wand at all 
because the shutter is not open while it is strobing.

If the shutter duration is set too high, the camera will see the wand in several 
places because the wand strobed more than once during the period the 
shutter was open.

Note 
Vicon Active Wands do not work at system frame rates below 50Hz.


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The first situation is easy to spot by looking at the video screen on the camera.  
As long as the video is synced to the same source as the Vicon system, the 
strobes are clearly visible.  If they are not, increase the shutter duration to cause 
them to appear.

The second situation is harder to spot. You can detect it by pausing live video of 
a wand wave in Shogun Live and carefully stepping through the video frames to 
look for multiple wands.  Alternatively, set the shutter duration to a safe 
maximum value, as shown here:

Base 
rate (Hz)

SDI 
video 
std  

Video 
frame 
period 
(ms)

Vicon 
system 
rate (Hz)

Vicon 
frame 
period 
(ms)

Vicon 
frames 
per 
video 
frame

Safe max. 
shutter 
duration

25 1080p/25 
(1x)

40 50 (2x) 20 2 1 / 60 = 
16.7 ms

25 1080p/25 
(1x)

40 100 (4x) 10 4 1 / 120 = 
8.3 ms

25 1080p/50 
(2x)

20 100 (4x) 10 2 1 / 120 = 
8.3 ms

29.97 1080p/
29.97 (1x)

33.4 59.94 (2x) 16.7 2 1 / 60 = 
16.7 ms

29.97 1080p/
29.97 (1x)

33.4 119.88 
(4x)

8.3 4 1 / 120 = 
8.3 ms

29.97 1080p/
59.94 (2x)

16.7 119.88 
(4x)

8.3 2 1 / 120 = 
8.3 ms

Caution 
It might seem a good idea to reduce the shutter duration during 
calibration and then increase it afterwards for capture. However, this is 
not good practice because the shutter timing on the Blackmagic URSA 
4K Mini is not center-aligned. In other words, the middle of the shutter-
open time shifts as the duration is changed. If your video is always too 
dark, it may be better to reduce the Vicon system frame rate for 
calibration and increase it afterwards for capture, or choose a higher 
frame rate video standard.


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1.

2.

3.

4.

5.

Set up the video input device
On the System tab, ensure the required frame rate is selected (Choose 
shutter duration, video standard and system frame rate, page 106).

 

In the System Properties for the video input device, in the General section, 
ensure the Enabled and Calibrate options are selected.

 

Under Timecode Setup, ensure that  Use Timecode for Sync  is selected.

 

Ensure that the video standard is compatible with the Vicon system standard, 
and that there are no warnings such as this one:

Ensure that the correct timecode is present on the video. You should be able 
to see it counting up.
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1.

2.

3.

•

•

4.

Set up the connectivity device
Go to the System Properties for the Vicon Lock unit, and in the Genlock and 
Timecode section, ensure that Genlock Enabled is selected.

Ensure that Genlock Status shows that the Vicon Lock unit is genlocked.

Ensure that a valid timecode source is set for the Lock unit.

Lock or Lock+ Set the timecode source to VITC.

Lock Studio Set the timecode source to SDI.

On the Capture tab on the right, in the Data Capture panel, ensure that the 
system is genlocked and has timecode. This is indicated by two green circles.
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5. If you are running at 29.97Hz timecode, ensure that drop-frame modes are 
compatible between the Vicon Lock and the video input device.  
For example, if the Lock shows this:

 

The video input should show this:
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1.

2.

Calibrate the SDI video system
Before attempting to calibrate, ensure you have completed all the steps in the 
previous sections (for a list of the relevant sections, see Set up SDI video 
cameras, page 52).

Note that tracked circles are not visible until you select Activate Video 
Calibration, as described below.

If you want to add an SDI camera to a Vicon system that is already calibrated, see 
also SDI lens calibration example in Getting started with Vicon Shogun.

In the Camera Calibration panel, display the advanced options and click 
Activate Video Calibration.

Ensure that video camera is positioned so that items in its field of view, 
including the wand, can also be seen by the Vicon cameras.

Tip 
If you can't see any tracked circles on the wand, this may be due to 
the system and camera not being frame-aligned. To correct this, in 
the Genlock & Timecode Settings section, drag the slider for the 
Advanced setting, Genlock Offset, until the circles appear.


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3.

•

•

4.

5.

6.

As normal, mask out any artifacts that could be mistaken for circles by 
selecting Start Masking. To ensure that the image is not so bright that the 
whole view is masked, but not so dark that the camera is prevented from 
seeing the wand, do one of the following:

On the camera, reduce the aperture, ensuring that the wand is still visible; 
or

In Shogun Live, go to the System Properties for the Decklink card and in the 
Optical Mode section, adjust the Threshold setting.

Click Start Wave and ensure that the wand is waved so that it is seen by the 
SDI video camera as well as the Vicon cameras.
Note that video cameras normally see less wand information than optical 
cameras: half the amount seen by the optical cameras is usually enough for a 
good calibration.

During calibration, any time offset between the video camera and the system 
is calculated and automatically applied. If necessary, you can change the 
offset in the Timecode Setup section of the DeckLink properties. 

With video calibration turned off, you can now set the origin as normal.

Tip 
A setting of 0.6 is a good starting point for most studios, but for a 
very bright space, you may need a slightly higher value.


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Export and use an ST map
You can export lens maps (ST map as a 32-bit EXR file) for calibrated video 
cameras from Shogun Live as distortion maps. You can then import your 
calibrated video camera/lens into a game engine such as Unreal, or into your 
compositing software.

The ST map contains information about the distortion of the lens and has four 
channels: R, G, B, and A:

B and A store the location of the pixels in a pinhole/undistorted image, 
ranging from 0 to 1 in proportion to the width and height of the image. These 
two channels are used to distort the CG image to match the SDI camera 
output.

R and G store the location of the pixels in a raw/distorted image (currently 
unused).

To use a Shogun Live ST map, the first step is to export it from Shogun Live.

Export an ST map, page 114

Set up a live composure in Unreal Engine, page 115
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1.

2.

•

•

Export an ST map
Ensure the video camera(s) have been calibrated, then from the File menu, 
select Export Video Camera STMap.

In the Save Camera Distortion Map dialog box, locate a folder to which to 
export the ST maps.
ST maps for all video cameras are exported to this folder.
Each filename has the format: <Camera DeviceID>_<focal length in pixels- 
integer part>_<focal length in pixels - decimal part>_<date time stamp>.exr, 
for example, vi101_1064_535479_20210623165749.exr.

The ST map contains information about the distortion of the lens and has four 
channels: R,G,B,A:

B and A store the location of the pixels in a pinhole/undistorted image, 
ranging from 0 to 1 in proportion to the width and height of the image. These 
two channels are used to distort the CG image to match the SDI camera 
output.

R and G store the location of the pixels in a raw/distorted image (currently 
unused).

This is an example of an ST map:

You can use the exported ST maps in a number of ways, including in game 
engines, such as Unreal Engine, or in compositing software. The following 
example shows how to use the ST map to set up a live composure in Unreal 
Engine, using the Virtual Production template project.



B E Y O N D  M O T I O N

Export and use an ST map

Getting more from Vicon Shogun

05 October 2021

Page 115 of 148

1.

Set up a live composure in Unreal Engine
In Unreal Engine, to import the ST map into the content, right-click to create a 
new subfolder in the content folder.

 



B E Y O N D  M O T I O N

Export and use an ST map

Getting more from Vicon Shogun

05 October 2021

Page 116 of 148

2.

3.

Browse to the new folder, right-click and select Import to /Game /Distortion 
Maps to import the ST map that you exported from Shogun Live.

In the Import dialog box, locate and select the ST map file.
The ST map is displayed in the Content Browser. 
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4.

5.

In the Content Browser, navigate  to Content > VprodProject > Maps and 
double-click the LiveComp map.

In the Content Browser, navigate  to Content > VprodProject > Materials and 
double-click the M_Live_Comp material.
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6.

The default graph for the material looks like this:

 

Expand the note and right-click to add a new TextureSampleParameter2D 
node to the graph:
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7. Give the node an appropriate name:
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8. With the node selected, in the Details panel, find the Material Expression 
Texture Base. 
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9. Click on the default texture to browse for the ST map and start typing the 
name of the file.

The ST map image is displayed in both the Details panel and the node in the 
graph.
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10. Drag from the UV's pin on the FG (foreground) node:
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11. Add a new AppendVector node:

 



B E Y O N D  M O T I O N

Export and use an ST map

Getting more from Vicon Shogun

05 October 2021

Page 124 of 148

12.

13.

To 'undistort' the foreground layer in this example, connect in this way:

Save the asset:
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UDP capture broadcast/trigger
Vicon Shogun supports a simple UDP protocol to broadcast when capture has 
started. Shogun can also receive these messages, which can be used to trigger a 
capture remotely.

The port for broadcast and trigger is configurable and defaults to 30.

Note that the packet contents are null terminated.
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•

•

•

The XML file contains the following notifications:

Start notification, page 127

Stop notification, page 128

Complete notification, page 129

Timecode Start notification, page 130

Timecode Stop notification, page 132

Duration Stop notification, page 133
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Start notification
The following example shows a Start notification. Note that the broadcast must 
fit into one UDP packet.

The indents in the following example are for clarity: the actual packet is not 
indented. White space between tokens is removed.

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<CaptureStart>
    <Name VALUE="dance"/>
    <Notes VALUE="The pets ants crime deer jump. "/>
    <Description VALUE="The crowd pencil pets alert fold deer. With welcome 
practice representative complete great? Or jolly tiny memorise thread. However 
wool insect pipe! "/>
    <DatabasePath VALUE="D:/Jeremy/Susan/Captures/Take"/>
    <Delay VALUE="33"/>
    <PacketID VALUE="33360"/>
</CaptureStart>

Where:

Name The name of the trial, which is used as the filename for the 
capture files, for example <Name>.x2d.

Notes Any notes provided

Description Any description provided. Avoid very long description strings as 
the broadcast must fit into one UDP packet. If it does not, the 
broadcast is not sent.

DatabasePath The target path for the capture files.

Delay The number of milliseconds that the broadcast is made before 
the capture starts. This delay enables clients to do any 
preparation required to respond.

PacketID A number that individually identifies the packet. It is 
incremented for each packet generated. Use it to discard 
duplicate packets that are delivered by UDP. (This can happen if 
there are multiple paths between the broadcasting and listening 
machines.)
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•

Stop notification
The following example shows a Stop notification. It is a notification that 
capturing has stopped.

Note that writing the file to disk may not be complete. Wait for the 
corresponding Complete notification before trying to open the file.

Possible values for the result are:

SUCCESS - Everything was ok.

FAIL - Everything was not ok. Perhaps the disk ran out of room, or the system 
was unplugged. You may get a truncated file.

CANCEL - The user stopped the capture process. There will not be a 
Complete notification.

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<CaptureStop RESULT="SUCCESS">
    <Name VALUE="dance"/>
    <DatabasePath VALUE="D:/Jeremy/Susan/Captures/Take"/>
    <Delay VALUE="33"/>
    <PacketID VALUE="33361"/>
</CaptureStop>
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Complete notification
The following example shows a Complete notification. It indicates that the 
captured file is ready at the path specified. Note that:

When capture is complete, buffers have yet to be flushed to disk.

If the file is on a remote drive, it may be captured locally and then copied to 
the final location. This may take some time.

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<CaptureComplete>
    <Name VALUE="dance"/>
    <DatabasePath VALUE="D:/Jeremy/Susan/Captures/Take"/>
    <PacketID VALUE="33362"/>
</CaptureComplete>
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Timecode Start notification
The following example shows a Timecode Start notification. It is generated when 
the system is armed. Note that:

Capture starts when the system receives the timecode specified.

Additional notifications may be generated if the start timecode is updated 
after the system is armed.

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<CaptureStart>
    <TimeCode VALUE="0 38 10 17 0 0 0 4"/>
    <Name VALUE="slip"/>
    <Notes VALUE="The last ants great blade jump. "/>
    <Description VALUE="The truthful pencil pets ants crime deer. With geese 
trail representative complete crowd? Or jolly toothbrush slip thread. However 
worried insect nest! "/>
    <DatabasePath VALUE="D:/Captures/Take/DayOne/Final"/>
<PacketID VALUE="33364"/>
</CaptureStart>

Where:

TimeCode is represented as a sequence of integers delimited with spaces.

Hours

Minutes

Seconds

Frames

Sub-Frame (Always zero)

Field

0 - Even Field

1 - Odd Field

Standard

0 - PAL

1 - NTSC

2 - NTSC Drop
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3 - Film at 24fps

4 - NTSC Film

5 - 30Hz exactly

Sub-Frames Per Frame (the multiple of the timecode rate that the system is 
running at)
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Timecode Stop notification
The following example shows a Timecode Stop notification. Note that additional 
notifications may be generated if the Timecode Stop is updated after the system 
is armed or possibly even capturing.

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<CaptureStop>
    <TimeCode VALUE="0 46 27 15 0 0 0 4"/>
    <Name VALUE="slip"/>
    <DatabasePath VALUE="D:/Captures/Take/DayOne/Final"/>
    <PacketID VALUE="33365"/>
</CaptureStop>

The values for TimeCode are as listed in Timecode start notification, page 130.
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Duration Stop notification
The packet is generated when the system is armed, or immediately prior to the 
capture being started.

<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<CaptureStop>
    <Duration FRAMES="12867" PERIOD="32865" TICKS="5553087"/>
    <Name VALUE="memorise"/>
    <DatabasePath VALUE="D:/Take/DayOne/Final/Susan"/>
    <PacketID VALUE="33367"/>
</CaptureStop>

Where:

 Duration is the number of frames that will be captured.

The packet may contain extra information describing the frame rate:

PERIOD is the number of clock ticks between each frame

TICKS is the number of ticks in each second

The frames per second of the system can be calculated as TICKS/PERIOD. This 
representation of the frame rate avoids rounding errors for rates such as NTSC, 
which cannot be stored in a double without a loss of precision.

<Duration FRAMES="12867" PERIOD="653254" TICKS="135000000" />
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Example Code
The examples are provided in C++ and require the boost library for 
communications.

CaptureBroadcastMonitor shows how to monitor for and decode the capture 
notifications described above.

RemoteStartStop shows how to package and send the packets to trigger 
capture start and stop.
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Specify folders in Shogun Post
Shogun Post lets you define folders for subject templates (VST or VSS files), 
subjects, skins, props, prop meshes and retargets. You do this in the Preferences 
dialog box. 

In a similar way to the Scripts tab, the default folders are listed at the top of the 
tab.
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To add or remove folders, click the Add and Remove buttons at the top right of 
the dialog box. You can also open the selected folder by clicking Open Folder or 
the browse button.

Subject Templates folders: Contain the VST or VSS files that you load to 
create and calibrate a new subject.

Subjects folders: Contain VSK and VSS files (labeling and solving setup files) 
for saved subjects.

Skins folders: Contain FBX files that can be used to define the mesh used with 
a VSS skeleton.

Props folders: Contain VSK and VSS files (labeling and solving setup files) for 
saved props.

Prop Meshes folders: Contain FBX files that can be used to define the mesh 
used with a prop.

Retargets folder: Contains VSR files used in retargeting.

The folders listed on these tabs affect the choices that are displayed in the 
Subject Setup panel, on the Labeling, Solving, Retargeting and Props tabs.

On the Labeling tab, when the More button ( ) next to Import Labeling 
Template is selected, the VST files found in the Subject Templates folders that 
are defined in the Preferences dialog box are listed. To see all the VST files, click 
the down arrow below.

Similarly, on the Solving tab, when the button next to Import Solving Template is 
selected, the VSS files found in the Subject Templates folders that are defined in 
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the Preferences dialog box are listed. To see all the VSS files, click the down 
arrow below.

The skin FBX files that are found in the Skins folders that are defined in the 
Preferences dialog box are also listed. To see all the skins files, click the down 
arrow.

To change the skin for an existing subject:

With the VSS subject selected, in the Subject Setup panel, on the Solving tab, 
click the Modify Setup tab.

In the Skin section, from the Change Skin list, select the required skin. (The 
skins listed are all the skin FBX files that are defined in the Preferences dialog 
as described above.)

Tip 
Avoid giving templates or skins the same name in multiple folders. If 
you use the same names, you will find it difficult to select the 
required file from the the drop down lists, as only the name of the file 
is listed, not the full path.


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In a similar way, you can change the mesh for an existing selected prop by 
clicking the Props tab, and on the Modify Setup tab, selecting the required mesh 
from the Change Mesh list.
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Using marking menus
Marking menus are tool sets that pop up as you work. They provide easy access 
to Shogun Post commands or scripts, regardless of where your mouse is pointing 
or what you are doing. Custom marking menus are a great way to create groups 
of commands for common tasks.

The scripts used in marking menus must exist within the directories specified 
in the Preferences dialog box (General > Preferences), on the Scripts tab within 
the Directories tab (explained in Set script folder locations, in HSL scripting with 
Vicon Shogun).

Shogun Post has three default marking menus: each contains five zones. Each 
zone has three mouse buttons. Each zone/mouse button combination has 
positions for eight menu items containing scripts or commands.

You can customize the marking menus by assigning scripts and commands to 
suit your preferences. You can save marking menu settings to the Shogun Post 
marking menu file (MarkingMenus.hsl) or create marking menu files of your own. 
You can use marking menus whenever you want to quickly access assigned 
scripts or commands.

You may also find it useful to create your own folder for storing any marking 
menus you create or customize.

To specify the location of the Marking Menu folder:

Open the the Preferences dialog box (see above).

On the Directories tab, click the Scripts tab and enter or browse to the 
location in the Marking Menu File field.

For more information, see:

Default marking menus, page 140

Customize marking menus, page 142

Use marking menus, page 145
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Default marking menus
The following tables describe the high-level contents of the default marking 
menus supplied with Shogun Post. For details of the individual commands in 
each of these zones, see the Marking Menus tab in the Preferences dialog box as 
described in Customize marking menus, page 142.

Default (Space) marking menu contents

Zone Left mouse Middle mouse Right mouse

Center Tracking — Parent/Child

Top — — —

Left Capture — —

Bottom — — —

Right Solving — —

Ctrl (Ctrl+Space) marking menu contents

Zone Left mouse Middle mouse Right mouse

Center — — —

Top — — —

Left — — —

Bottom — — —

Right — — —
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Shift (Shift+Space) marking menu contents

Zone Left mouse Middle mouse Right mouse

Center Select Sets — —

Top — — —

Left Select Types — —

Bottom — — —

Right Hierarchy Selections — —
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5.

•

•

•

6.

7.

Customize marking menus
You can customize marking menus by assigning new commands to zones and 
mouse buttons.

To customize marking menus:

Open the Preferences dialog box (General > Preferences).

Click the Marking Menus tab, which contains drop-down lists and location 
controls.

From the Select a Marking Menu to edit drop-down list, click one of the 
default marking menus:

Default Menu (Space)

Ctrl Menu (Ctrl-Space)

Shift Menu (Shift-Space)

From the Select a zone to edit list, click one of the available zones:

Center

Top

Left

Bottom

Right

From the Select a mouse button list, click the desired button:

Left Button

Middle Button

Right Button

In Entry label, type the name you want to use for this marking menu.

Click the Commands button to display the Script Viewer.
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10.

•
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•

•
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•

Click the Style list and select an option for the way you want to view the 
available menu commands and scripts that can be assigned to marking 
menus (those that can execute without arguments):

List: All items listed in alphabetical order.

Hierarchy: Items grouped into categories of commands: Native 
Commands, Menu Commands, Plugin Commands, C:/Users/Public/
Documents/Vicon/Shogun Post#.#/Scripts, C:/Users/Public/Documents/
Vicon/Shogun Post#.#/Layouts, C:/Program Files/Vicon/Shogun Post#.#/
Scripts, C:/Program Files/Vicon/Shogun Post#.#/Layouts.

Category: Items grouped into script categories.

From the list, click the command or script you want to assign to a marking 
menu and click OK to close the Script Viewer.
The selected command or script is displayed in the Command string and 
Entry label fields in the Marking Menu Preferences dialog box.

Click the button that represents the mouse direction to which you want to 
assign the command:

North

Northeast

East

Southeast

South

Southwest

West

Northwest

The button is highlighted, and the name of the selected command is 
displayed in it. 
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11.

To assign commands to any of the other mouse directions for the currently 
selected zone and mouse button, repeat steps 6–10 .
To assign commands to a different mouse button in the currently selected 
zone, Repeat the procedure from step 5.
To assign commands to a different zone and mouse buttons, repeat the 
procedure from step 4.

When you are finished customizing marking menus, click Close to save the 
changes and close the Preferences dialog box.

Tip 
You can replace the default command name displayed in the 
selected mouse direction field with a custom name by entering a new 
value in the Entry label field. You can add additional scripts to a 
single mouse direction by entering a semicolon and a space, and 
then manually typing in the name of an additional command. 
Separate each additional script with a semicolon and a space, for 
example: rewind; play;


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Use marking menus
You can access marking menus from anywhere and at any time while you are 
working with data in Shogun Post. The menu that pops up depends on your 
current zone and the mouse button that you are using.

To use a marking menu:

Note that the following instructions assume that default menu has been assigned 
the Space hotkey, the Ctrl menu has been assigned the Ctrl+Space hotkeys and 
the Shift menu has been assigned the Shift+Space hotkey. You can find 
information on how to do this in Set hot keys, page 145.

In a view pane, display the desired marking menu as shown in the following 
table.

To display this marking menu Press and hold keys

Default menu (showMarkingMenu
command)

Space

Ctrl menu (showCtrlMarkingMenu
command)

Ctrl+space

Shift menu (showShiftMarkingMenu
command)

Shift+space

Hover the mouse over the right, left, top, bottom, or center zone and then 
left-click, middle-click, or right-click to view the sets of commands defined for 
that zone/mouse button.

Left-, middle-, or right-click the desired mouse direction to run the associated 
script or command.

Set hot keys for marking menus
If required, you can set or clear hot keys for displaying marking menus, by 
changing the hot key for showMarkingMenu. For information on how to set hot 
keys for this and other commands, see Set hot keys in Post in Getting started 
with Vicon Shogun.
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Vicon Shogun command line options
You can use command line options for Shogun Live and Shogun Post.

Shogun Live command line options, page 147

Shogun Post command line options, page 148
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Shogun Live command line options
Shogun Live supports the following command line options:

Option Description

--help List supported command line options.

--log <level> Set logging level to one of [Off, Always, Error, Warn, 
Info, Default, Debug].

--force-gles Load in Graphics Compatibility mode.

--terminal-port 
<port number>

Specify a port number for the Live API terminal server (the 
default is 52800).

--nosplash Do not show the splash screen.

--log-dir <path> Specify a directory in which to save the log file (overrides default 
location).

--agent-host-
ip=<host IP>

Where host IP is the IP address of the machine. Used to 
extract a subnet for harvesting network interfaces when setting 
up multi-machine Shogun processing. For details, see Run 
Shogun processing on multiple machines, page 42.

Example usage:

> C:\Program Files\Vicon\ShogunLive1.7\ShogunLive.exe --log Info 
--log-dir C:\tmp\ShogunLiveLogs

> C:\Program Files\Vicon\ShogunLive1.7\ShogunLive.exe --agent-
host-ip=192.168.1.100
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Shogun Post command line options
Shogun Post supports the following command line options:

Option Description

--force-gles Load in Graphics Compatibility mode. 

--SkipSplash Do not show the splash screen.

--crash-handler <string> Optionally, specify quiet or system.
If used with no argument, the Vicon crash 
handler is used.

--exit-after-script Close Shogun Post after running the init script.

Example usage:

> C:\Program Files\Vicon\ShogunPost1.7\ShogunPost.exe --SkipSplash
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